
ITRL ePortfolio Instructions 
 

 
To have a working, functional ePortfolio on your own Webspace, you need to 

follow three main steps: 
 

1. Setting up your Web space 
 

2. Downloading the template and building your ePortfolio 
 

3. Loading your ePortfolio to your Web space 
 
 
 

These instructions are designed for users who have very limited experience with 
building their own Web page, so feel free to skip ahead if you already have your own 
Web space and want to move on to the later stages of the walkthrough. 
 
 
 

Part 1: Setting up your Web space 
 

The first step in creating your ePortfolio is to set up your very own Web space 
from which you will host your finished ePortfolio. In order for your ePortfolio to be 
visible on the Web at any given time, it must be saved on a computer that is constantly 
connected to the internet (otherwise known as a server). Web space on a server can be 
acquired online from a variety of different hosts, usually on an annual basis and for a fee. 
If you already have Web space on a server, please feel free to use it to host your 
ePortfolio. However, if you do not yet have any Web space and you do not want to pay a 
fee, there is a free and easy way to set up your Web space on the University server. 

 
Every individual who has a Campus Computing ID (CCID) at the University of 

Alberta is allotted 1GB of Web space on the main GPU server. However, you will not be 
able to access this Web space unless you go through the necessary steps to activate it. In 
order to set up, activate, and access your GPU Web space, please follow these three 
simple steps: 

 
Step #1: Acquire the necessary programs 

 
Before you begin, you need to make sure that the computer you are using has two 

programs called PuTTY and WinSCP. Most University computers will already have these 
programs installed, but they are also available for download at: 

  
http://www.ualberta.ca/AICT/SOFTWARE/filetransfer.html for WinSCP 

 http://www.ualberta.ca/AICT/SOFTWARE/auth.html for PuTTY 0.57 

http://www.ualberta.ca/AICT/SOFTWARE/filetransfer.html
http://www.ualberta.ca/AICT/SOFTWARE/auth.html


To download the programs, click on one of the links above and find the program 
amongst the list of downloads available. Please note that if you click on the link for the 
program name (PuTTY 0.57 or WinSCP) it will simply take you to an information page about 
the program. To download the program, you must click on the link on the right side of the 
page. The link will be the actual file size of the program (1.2MB or 1.9MB) and will be 
located to the right of the Windows icon  . After clicking on the link, you will be 
prompted to enter your CCID and password; once you do so, the program will start to 
download. Click “Run” to automatically begin the installation, and just click on “Next” to 
install the default version of the program.  

 

 
 
 Step #2: Setting up your GPU account 
 

 Now that you have both programs installed, open up PuTTY and enter the GPU 
server as the Host Name: 
  gpu.srv.ualberta.ca 

 Now click on “Open” at the bottom of the page. A new PuTTY window will 
open where you can login using your CCID and password.  

Now you need to enter a few commands to set up your GPU account. These 
commands will probably not make any sense to you, but fortunately they don’t have to! 
Just make sure that you enter the commands EXACTLY as you see them printed here 
(including spaces between letters and words!) and press the “Enter” key after each line. 

 
First, we will restore the proper shell by entering the following command: 
 
  /etc/skel/getdotfiles 
 
Press “Enter” to return the command. You now need to log out (by closing the 

window) of PuTTY and login again. Once you have logged in again, you can type in the 
following set of commands to set up your public directory (remember to press “Enter” 
after each line and please note that every “l” in the following commands is the lower-case 
LETTER "L", not the number!): 

  fs setacl ~ system:anyuser l 
  cd ~ 
  mkdir public_html 
  fs setacl ~/public_html system:anyuser rl 
 
After this is complete, you can close the Putty session. Congratulations – you 

have activated your Web space on the GPU account!  
  
 
  Step #3: Adding files to your Web space 
 
You can now load files to your web space using the WinSCP program. This entire 

process is explained in detail in Part 3 of this tutorial.  
 

http://www.chiark.greenend.org.uk/%7Esgtatham/putty/
http://winscp.net/eng/index.php


 
Part 2: Downloading the template and building your ePortfolio 

 
Now that you have set up your Web space, we can move on to creating the html 

content that will appear on your Web site. The ITRL ePortfolio package is designed to 
provide anyone, regardless of their technical skills and knowledge, with the ability to 
create and maintain a professional electronic portfolio on the Web. To accomplish this, 
the ePortfolio package has been set up as a TEMPLATE. This means that most of the 
content information has already been structured: all that you have to do is plug in your 
own information.  

 
 

The Technical Stuff 
 

 Our ePortfolio template consists of a series of linked Web pages, which were  
constructed using hyper text markup language (html). As a brief explanation, html is 
essentially the language of the internet; it exists behind the scenes and tells your Web 
browser what to display on your screen. So, any time that we refer to html in these 
instructions, we are talking about the programming language that the ePortfolio was 
created with. 

Another important feature we should mention is that the html templates we have 
provided were constructed using Cascading Style Sheets. This means that the overall 
content and html markup does not contain ANY information in regards to the STYLE of 
the Web page. All style information is included in a separate file known as a Style Sheet. 
The download package contains several Style Sheets that you can choose from to 
customize the style of your ePortfolio. This may sound confusing right now, but as you 
begin working with the template you will soon understand the nature and function of a 
Style Sheet.  

 
Downloading the Template 

 
 After downloading the template from the Web site, you should have a zip file on 
your computer. You can unzip the file with WinZip, which your computer should already 
have, but if it doesn’t you can download it from  
http://www.download.com/3000-2250-10003164.html . Once the file is unzipped, it 
should appear as a folder called “student”. Before you make any changes to the files 
inside this folder, you should change the name of the folder to “ePortfolio”. This is an 
important step to make, because later, when you load this folder to your Web space, the 
name of this folder will become a part of the URL. Once you have re-named the folder, 
open it up and take a look inside. You should see a few folders, some html pages, and 
some css pages. The “Documents” folder is where you will be putting any of the Word 
files or pdf’s that you will be loading to your ePortfolio, while the “Images” folder will 
contain ALL of the images for your ePortfolio. 
 

Acquiring the Necessary program for html editing 
 

http://www.download.com/3000-2250-10003164.html


 Since you may not have any experience working with html and building Web 
pages, it might be a good idea to acquire an html editing program. While there are many 
excellent programs available (eg. Dreamweaver, Homesite), these programs are usually 
expensive and you may not have them on your computer. Because of this, we have found 
a free and easy to use program for html editing called First Page that you can download 
and use to edit your ePortfolio. You can use any html editor that you are comfortable 
with, but if you do not have any html editing programs and would like more detailed 
instructions, we recommend that you complete the First Page download and follow the 
corresponding instructions below. 
 You can download First Page from the following address: 
http://www.evrsoft.com/download.shtml 
 

*Using First Page to Edit the ePortfolio Template* 
  
 Once you have downloaded the program or obtained another html editor, go 
ahead and open the program. As the program begins to load, you will be prompted to 
select the type of document you want to create. Since we will be opening an modifying a 
file that already exists, simply click on the “Cancel” button. You will now see the main 
interface of First Page, which is divided into 4 main screens. The two sections on the left 
side of the page are where you can browse for and open your html files. The right side of 
the screen contains the html source code for the current page.  
 Let’s try opening up one of the template html pages. Go to the upper left side of 
the screen and browse for your ePortfolio folder. When you find it and click on it, all of 
the html files within the folder should appear on the bottom left of the screen. Lets try 
opening up the main page or “index” page for your ePortfolio by double clicking on the 
file called “index”. When you do this, the file will load on the right hand side of the 
screen; you should see programming code (this is html!) in the top part of the screen, and 
on the bottom of the screen you should see a preview version of your Web page. 

Take a look at the top of this section; you should see 4 tabs called “Source”, 
“Preview”, “Design”, and “Reference”. We are now viewing the Web page under the 
Source view, which means we are viewing the html source code for the Web page. The 
bottom part of the screen is only a PREVIEW and any changes that we make to it will be 
through editing the html code, so you should NOT try editing the Web page from this 
screen unless you have experience with html code. Instead, lets click on the “Design” tab 
to open up a WYSIWYG(what you see is what you get) mode that will allow you to 
quickly and easily change the content of your ePortfolio.  

When you click on the “Design” tab, you will receive a warning that the 
“WYSIWYG mode significantly modifies html code” and will ask you whether or not 
you want to continue. You can click the box at the bottom to make sure that the message 
doesn’t appear again and then select “Yes” to proceed. The page will now load in a 
design format where you can simply select text to modify it. Since this is a template, all 
of the menu items are already set up to go to their own pages (please do NOT try to 
modify or add menu items), so all that you have to do is add your name at the top of the 
page and enter your own information and picture in the content section of the page. To 
add content, all that you have to do is highlight the template text, delete it, and type in 

http://www.evrsoft.com/download.shtml


your own! If you ever make a mistake that you cannot correct, select the “Undo” 
command below the “Edit” menu at the top of the page.  

One important thing you should know is that you should NOT try and edit ANY 
of the style information on your ePortfolio. Do not try to change the font, size, colour, 
background, or design of the template or the writing in any way; this template was 
created using a Style Sheet, and thus any style information that you try to include my 
cause problems with the programming. Rest assured that you WILL get a chance to 
change the style information on your ePortfolio, but for now all that you need to do is 
enter the content information into the template.  
 

Adding your own pictures and files 
 

 Before you can add your own pictures and documents to your Web pages, you 
need to transfer the files to their corresponding folders within your ePortfolio folder. By 
copying all of the files into your ePortfolio folder, you are making sure that all of your 
documents and images will remain intact when you put your ePortfolio on your Web 
space. So, you should find any of the images that you want to include in your ePortfolio 
and copy them into the “Images” folder before you try to browse for them in First Page 
and add them to your Web page. Likewise, any documents that you may want to include 
with your ePortfolio (ie. writing samples, pdf versions of your resume, photocopied 
scholarships, electronic CV’s etc) should be copied into the “Documents” folder inside of 
your ePortfolio folder. 
  Now, in order to add an image to your Web page, you need to browse for the 
image within First Page. On the top left hand side of the screen, browse for the “Images” 
folder inside of your ePortfolio folder. Once you click on this folder, the image files 
contained within should appear in the bottom left hand side of the screen. To add the 
picture to your Web page, simply click on the file and drag it to the appropriate part of 
the page. If you need to resize the image, you can do so before you even load the file or 
right in First Page by clicking on the image and dragging the corners. 
  

Adding direct and relative links 
 

 There are two types of links that you can have on your Web page; direct 
links(hyperlinks) and relative links. Direct links, which are also known as hyperlinks, are 
connected to other Web pages DIRECTLY, meaning that the link is directed to the full 
URL of an existing Web page. You can create these kind of links in First Page simply by 
highlighting the text that you want to make into a link, right-clicking on the text, and 
selecting “Make hyperlink”. Once you do this, you simply enter the full URL of the Web 
page you want to link to.  

Relative links are links that connect to files and other Web pages within the 
SAME folder as the current html file (ie. all of the other Web pages and documents in 
your ePortfolio folder). For example, to create a download link to your pdf resume, you 
would do so using a relative link. To do this, simply highlight the text that you want to 
make into a link, go to the “Insert” menu at the top of the page, and select “Link to Local 
File”. This will open up a window that will allow you to browse for the pdf file in your 
“Documents” folder. Under the “Files of type:” option, you may need to select “All 



Files” before you can find the file, but once you do so you should be able to select the file 
and click “Open”. Likewise, you can also create relative links to any of the other html 
files in your ePortfolio folder. Just remember, if the document or html file has not been 
saved locally (within the same parent ePortfolio folder), you will not be able to create a 
working link to it. 

 
Adding Content to the rest of your ePortfolio 

 
 After you have added your own content to your “index” page, you can do the 
same with the other html pages in your ePortfolio. Make sure that you save your changes 
and try loading one of the other html files. Go through the “About Me”, “Resume”, and 
“Sample Work” pages to replace the template text with your own personal information. If 
you need more space or more columns and rows in some of the tables provided, simply 
copy and paste the sections that you need (if you try to create them yourself, you may 
ruin the template formatting). Again, since the entire template was made using a Style 
Sheet, it is very important that you do not try to change any of the style and formatting 
information on the Web pages. Go ahead and use what you have learned about relative 
links to load any documents or images you might want to include. The “Links” page is an 
entire page where you can add any important hyperlinks that you may want to include 
with your ePortfolio. 
 

Adding an email link 
 

 In the menu portion on all of your html pages, the very last item is an “Email” 
function. This part of the menu is where the user can click if they want to send you an 
email. To set this up, we need to give the “Email” menu item a special kind of link for 
email. To do this, highlight the “Email” in the menu, go to the “Insert” menu at the top of 
the page, and select “Email…”.  Once you do this, a window will open where you can 
simply fill in your email address. Click on “Okay” and your email link will be created; 
just make sure that you do this on ALL of your html pages or the link will not work on 
those pages. 
 

Choosing your Style Sheet 
 

 Once all of the content has been added to your ePortfolio and you have saved all 
of your changes, you can finally start implementing some style changes. Since the 
template uses Style Sheets to implement style information, you need to change the Style 
Sheet to change the overall look of the ePortfolio. To change the Style Sheet for any of 
your html documents, all that you need to do is change one line of html code. Open up 
your ePortfolio index page and click on the Source tab to look at the html code near the 
top of the document. You should see a line of code in the head of the document that looks 
like this: 
   
 <link rel="stylesheet" href="basicstyle.css" type="text/css"> 
 



 The first and last sections of this line of code simply tell the Web browser what 
kind of file the page is linked to; we are only interested in the middle section of code: 
 
 href="basicstyle.css" 
 
 This line tells the browser which specific css file we are drawing our style 
information from. In order to switch style sheets, all that we have to do is change the 
name of the file “basicstyle.css” (the default Style Sheet for your ePortfolio html files). 
Take a look in your ePortfolio folder and look at all of the files that end in .css – these are 
all of your Style Sheet files. Try replacing the basicstyle.css file with one of the other 
Style sheets available, like the greenandgold.css file. When you are done, the line of code 
in your html file should now look like this: 
 
 <link rel="stylesheet" href="greenandgold.css" type="text/css"> 
 
 Save your index file, and then click on the “Preview” tab to see the changes 
implemented. Take a look at the differences in color and style now that you have loaded a 
new Style Sheet! Try loading some of the other Style Sheets until you find one that you 
want to use with your ePortfolio. Once you find the Style Sheet that you want, you should 
make sure that ALL of your ePortfolio pages are linked to it. To do this, go into your 
ePortfolio and open up all of the html files in your html editing program. Then check the 
html code at the top and make sure the correct Style Sheet has been loaded in ALL of 
them. Remember, each page must be referenced to the correct style sheet or it will appear 
drastically different in style and presentation than the rest of your pages! 
  
 

 
Part 3: Loading your ePortfolio to your Web space 

 
To begin, open up the WinSCP program that you downloaded in Part 1 and click 

on “New” to create a new account. Enter gpu.srv.ualberta.ca as the Host Name, and use 
your CCID and password to login. You can save your login settings by clicking on the 
“Session” menu and selecting “Save Session”. This will allow you to quickly and easily 
access your Web space without having to enter your CCID and password every time. 

Once you have logged in, your own personal WinSCP window containing two 
frames will open. The frame on the left represents the files on your hard drive and the 
frame on the right represents the files in your Web space. 

 In the right frame, make sure that you double click and open the folder called 
“public_html”. Any files that you transfer to your Web space must be placed into this 
folder or they will not be viewable on the Web. 

In the left frame, browse for your ePortfolio FOLDER. It should contain all of 
your html files, documents, and images. Once you find the folder, simply click on it and 
drag it to the right side of the WinSCP window into your public_html folder. A pop-up 
window will open for you to verify the location of the file transfer; all that you have to do 



is click on “Copy”. This will transfer your entire ePortfolio folder an all of its contents to 
your Web space. 

Now that you have created and posted your files, all that you have to do is check 
out your new ePortfolio! To access the html files online, simply type in the URL of your 
directory: 

  
http://www.ualberta.ca/~YOURCCID/  

 
 For example, my name is Christopher Goetz, and my CCID is cgoetz. This means 
that the URL to MY Web space is: 
 
 http://www.ualberta.ca/~cgoetz/  
 

If you enter this URL into your browser, it should take you to your Web space 
directory where you can see your ePortfolio folder. When you click on it, the index page 
of your ePortfolio will automatically load! Take a look at the URL – this is the new link 
for your very own personal ePortfolio! This is the link that you can add to resumes, share 
with friends and family, and forward to potential supervisors and employers! You’ve 
done all of the work to make it happen…now go ahead and share your information with 
the world. Go ahead…..Get Connected! 

 
 
 
 
 
 
 
 


